
Chapter 13: Modeling Species Transport and Gaseous Combustion

This tutorial is divided into the following sections:

13.1. Introduction

13.2. Prerequisites

13.3. Problem Description

13.4. Background

13.5. Setup and Solution

13.6. Summary

13.7. Further Improvements

13.1. Introduction

This tutorial examines the mixing of chemical species and the combustion of a gaseous fuel.

A cylindrical combustor burning methane ( ) in air is studied using the eddy-dissipation model in

ANSYS Fluent.

This tutorial demonstrates how to do the following:

• Enable physical models, select material properties, and define boundary conditions for a turbulent flow with

chemical species mixing and reaction.

• Initiate and solve the combustion simulation using the pressure-based solver.

• Examine the reacting flow results using graphics.

• Predict thermal and prompt NOx production.

• Use custom field functions to compute NO parts per million.

13.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory

tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing El-

bow (p. 1)

• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)

• Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 121)

and that you are familiar with the ANSYS Fluent tree and ribbon structure. Some steps in the setup and

solution procedure will not be shown explicitly.

To learn more about chemical reaction modeling, see the Fluent User's Guide and the Fluent Theory

Guide. Otherwise, no previous experience with chemical reaction or combustion modeling is assumed.
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13.3. Problem Description

The cylindrical combustor considered in this tutorial is shown in Figure 13.1: Combustion of Methane

Gas in a Turbulent Diffusion Flame Furnace (p. 538). The flame considered is a turbulent diffusion flame.

A small nozzle in the center of the combustor introduces methane at 80  . Ambient air enters the

combustor coaxially at 0.5  . The overall equivalence ratio is approximately 0.76 (approximately 28

 excess air). The high-speed methane jet initially expands with little interference from the outer wall,

and entrains and mixes with the low-speed air. The Reynolds number based on the methane jet diameter

is approximately .

Figure 13.1:  Combustion of Methane Gas in a Turbulent Diffusion Flame Furnace

13.4. Background

In this tutorial, you will use the generalized eddy-dissipation model to analyze the methane-air combus-

tion system. The combustion will be modeled using a global one-step reaction mechanism, assuming

complete conversion of the fuel to  and . The reaction equation is

(13.1)

This reaction will be defined in terms of stoichiometric coefficients, formation enthalpies, and parameters

that control the reaction rate. The reaction rate will be determined assuming that turbulent mixing is

the rate-limiting process, with the turbulence-chemistry interaction modeled using the eddy-dissipation

model.

13.5. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:

13.5.1. Preparation

13.5.2. Mesh

13.5.3. General Settings

13.5.4. Models

13.5.5. Materials

13.5.6. Boundary Conditions

13.5.7. Initial Reaction Solution

13.5.8. Postprocessing

13.5.9. NOx Prediction

13.5.1. Preparation

To prepare for running this tutorial:
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1. Set up a working folder on the computer you will be using.

2. Go to the ANSYS Customer Portal, https://support.ansys.com/training.

Note

If you do not have a login, you can request one by clicking Customer Registration on

the log in page.

3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.

a. Click ANSYS Fluent under Product.

b. Click 18.0 under Version.

5. Select this tutorial from the list.

6. Click the species_transport_R180.zip link to download the input files.

7. Unzip species_transport_R180.zip to your working folder.

The file gascomb.msh can be found in the species_transport folder created after unzipping

the file.

8. Use Fluent Launcher to start the 2D version of ANSYS Fluent.

Fluent Launcher displays your Display Options preferences from the previous session.

For more information about Fluent Launcher, see starting ANSYS Fluent using the Fluent Launcher in

the Fluent Getting Started Guide.

9. Ensure that the Display Mesh After Reading and Workbench Color Scheme options are enabled.

10. Enable Double-Precision.

11. Ensure Serial is selected under Processing Options.

13.5.2. Mesh

1. Read the mesh file gascomb.msh.

File → Read → Mesh...

After reading the mesh file, ANSYS Fluent will report that 1615 quadrilateral fluid cells have been read,

along with a number of boundary faces with different zone identifiers.

13.5.3. General Settings

1. Check the mesh.
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Setting Up Domain → Mesh → Check

ANSYS Fluent will perform various checks on the mesh and will report the progress in the console. Ensure

that the reported minimum volume reported is a positive number.

2. Scale the mesh.

Setting Up Domain → Mesh → Scale...

Since this mesh was created in units of millimeters, you will need to scale the mesh into meters.

a. Select mm from the Mesh Was Created In drop-down list in the Scaling group box.

b. Click Scale.

c. Ensure that m is selected from the View Length Unit In drop-down list.

d. Ensure that Xmax and Ymax are reset to 1.8 m and 0.225 m respectively.

The default SI units will be used in this tutorial, hence there is no need to change any units in this

problem.

e. Close the Scale Mesh dialog box.

3. Check the mesh.

Setting Up Domain → Mesh → Check

Note

You should check the mesh after you manipulate it (scale, convert to polyhedra, merge,

separate, fuse, add zones, or smooth and swap). This will ensure that the quality of the

mesh has not been compromised.
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4. Examine the mesh with the default settings.

Figure 13.2: The Quadrilateral Mesh for the Combustor Model

Extra

You can use the right mouse button to probe for mesh information in the graphics win-

dow. If you click the right mouse button on any node in the mesh, information will be

displayed in the ANSYS Fluent console about the associated zone, including the name of

the zone. This feature is especially useful when you have several zones of the same type

and you want to distinguish between them quickly.

5. Select Axisymmetric in the 2D Space list.

Setup → General
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13.5.4. Models

1. Enable heat transfer by enabling the energy equation.

Setting Up Physics → Models → Energy

2. Select the standard -  turbulence model.

Setting Up Physics → Models → Viscous...
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a. Select k-epsilon (2 eqn) in the Model list.

The Viscous Model dialog box will expand to provide further options for the k-epsilon model.

b. Retain the default settings for the k-epsilon model.

c. Click OK to close the Viscous Model dialog box.

3. Enable chemical species transport and reaction.

Setting Up Physics → Models → Species...
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a. Select Species Transport in the Model list.

The Species Model dialog box will expand to provide further options for the Species Transport

model.

b. Enable Volumetric in the Reactions group box.

c. Select methane-air from the Mixture Material drop-down list.

Scroll down the list to find methane-air.

Note

The Mixture Material list contains the set of chemical mixtures that exist in the ANSYS

Fluent database. You can select one of the predefined mixtures to access a complete

description of the reacting system. The chemical species in the system and their

physical and thermodynamic properties are defined by your selection of the mixture

material. You can alter the mixture material selection or modify the mixture material

properties using the Create/Edit Materials dialog box (see Materials (p. 545)).

d. Select Eddy-Dissipation in the Turbulence-Chemistry Interaction group box.
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The eddy-dissipation model computes the rate of reaction under the assumption that chemical kinetics

are fast compared to the rate at which reactants are mixed by turbulent fluctuations (eddies).

e. Click OK to close the Species Model dialog box.

Prior to listing the properties that are required for the models you have enabled, ANSYS Fluent will display

a warning about the symmetry zone in the console. You may have to scroll up to see this warning.

Warning: It appears that symmetry zone 5 should actually be an axis

          (it has faces with zero area projections).

          Unless you change the zone type from symmetry to axis,

          you may not be able to continue the solution without

          encountering floating point errors.

In the axisymmetric model, the boundary conditions should be such that the centerline is an axis type

instead of a symmetry type. You will change the symmetry zone to an axis boundary in Boundary Condi-

tions (p. 548).

13.5.5. Materials

In this step, you will examine the default settings for the mixture material. This tutorial uses mixture properties

copied from the Fluent Database. In general, you can modify these or create your own mixture properties

for your specific problem as necessary.

1. Confirm the properties for the mixture materials.

Setup → Materials → Mixture → methane-air Edit...

The Create/Edit Materials dialog box will display the mixture material (methane-air) that was selected

in the Species Model dialog box. The properties for this mixture material have been copied from the

Fluent Database... and will be modified in the following steps.

a. Click the Edit... button to the right of the Mixture Species drop-down list to open the Species dialog

box.
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You can add or remove species from the mixture material as necessary using the Species dialog box.

i. Retain the default selections from the Selected Species selection list.

The species that make up the methane-air mixture are predefined and require no modification.

ii. Click OK to close the Species dialog box.

b. Click the Edit... button to the right of the Reaction drop-down list to open the Reactions dialog box.
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The eddy-dissipation reaction model ignores chemical kinetics (the Arrhenius rate) and uses only the

parameters in the Mixing Rate group box in the Reactions dialog box. The Arrhenius Rate group

box will therefore be inactive. The values for Rate Exponent and Arrhenius Rate parameters are

included in the database and are employed when the alternate finite-rate/eddy-dissipation model is

used.

i. Retain the default values in the Mixing Rate group box.

ii. Click OK to close the Reactions dialog box.

c. Retain the selection of incompressible-ideal-gas from the Density drop-down list.

d. Retain the selection of mixing-law from the Cp (Specific Heat) drop-down list.

e. Retain the default values for Thermal Conductivity, Viscosity, and Mass Diffusivity.
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f. Click Change/Create to accept the material property settings.

g. Close the Create/Edit Materials dialog box.

The calculation will be performed assuming that all properties except density and specific heat are con-

stant. The use of constant transport properties (viscosity, thermal conductivity, and mass diffusivity

coefficients) is acceptable because the flow is fully turbulent. The molecular transport properties will play

a minor role compared to turbulent transport.

13.5.6. Boundary Conditions

Setup → Boundary Conditions

Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.548

Modeling Species Transport and Gaseous Combustion



1. Convert the symmetry zone to the axis type.

Setup → Boundary Conditions → symmetry-5

The symmetry zone must be converted to an axis to prevent numerical difficulties where the radius reduces

to zero.

a. Select axis from the Type drop-down list.

2. Set the boundary conditions for the air inlet (velocity-inlet-8).

Setup → Boundary Conditions → velocity-inlet-8 Edit...

To determine the zone for the air inlet, display the mesh without the fluid zone to see the boundaries.

Use the right mouse button to probe the air inlet. ANSYS Fluent will report the zone name (velocity-inlet-

8) in the console.
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a. Enter air-inlet for Zone Name.

This name is more descriptive for the zone than velocity-inlet-8.

b. Enter 0.5  for Velocity Magnitude.

c. Select Intensity and Hydraulic Diameter from the Specification Method drop-down list in the Tur-

bulence group box.

d. Enter 10  for Turbulent Intensity.

e. Enter 0.44  for Hydraulic Diameter.

f. Click the Thermal tab and retain the default value of 300  for Temperature.

g. Click the Species tab and enter 0.23 for o2 in the Species Mass Fractions group box.
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h. Click OK to close the Velocity Inlet dialog box.

3. Set the boundary conditions for the fuel inlet (velocity-inlet-6).

Setup → Boundary Conditions → velocity-inlet-6 Edit...

a. Enter fuel-inlet for Zone Name.
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This name is more descriptive for the zone than velocity-inlet-6.

b. Enter 80  for the Velocity Magnitude.

c. Select Intensity and Hydraulic Diameter from the Specification Method drop-down list in the Tur-

bulence group box.

d. Enter 10  for Turbulent Intensity.

e. Enter 0.01  for Hydraulic Diameter.

f. Click the Thermal tab and retain the default value of 300  for Temperature.

g. Click the Species tab and enter 1 for ch4 in the Species Mass Fractions group box.

h. Click OK to close the Velocity Inlet dialog box.

4. Set the boundary conditions for the exit boundary (pressure-outlet-9).

Setup → Boundary Conditions → pressure-outlet-9 Edit...

a. Retain the default value of 0  for Gauge Pressure.

b. Select Intensity and Hydraulic Diameter from the Specification Method drop-down list in the Tur-

bulence group box.

c. Enter 10  for Backflow Turbulent Intensity.

d. Enter 0.45  for Backflow Hydraulic Diameter.
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e. Click the Thermal tab and retain the default value of 300  for Backflow Total Temperature.

f. Click the Species tab and enter 0.23 for o2 in the Species Mass Fractions group box.

g. Click OK to close the Pressure Outlet dialog box.

The Backflow values in the Pressure Outlet dialog box are utilized only when backflow occurs at the

pressure outlet. Always assign reasonable values because backflow may occur during intermediate itera-

tions and could affect the solution stability.

5. Set the boundary conditions for the outer wall (wall-7).

Setup → Boundary Conditions → wall-7 Edit...

Use the mouse-probe method described for the air inlet to determine the zone corresponding to the

outer wall.

a. Enter outer-wall for Zone Name.

This name is more descriptive for the zone than wall-7.

b. Click the Thermal tab.

i. Select Temperature in the Thermal Conditions list.

ii. Retain the default value of 300  for Temperature.

c. Click OK to close the Wall dialog box.
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6. Set the boundary conditions for the fuel inlet nozzle (wall-2).

Setup → Boundary Conditions → wall-2 Edit...

a. Enter nozzle for Zone Name.

This name is more descriptive for the zone than wall-2.

b. Click the Thermal tab.

i. Retain the default selection of Heat Flux in the Thermal Conditions list.

ii. Retain the default value of 0  for Heat Flux, so that the wall is adiabatic.

c. Click OK to close the Wall dialog box.

13.5.7. Initial Reaction Solution

You will first calculate a solution for the basic reacting flow neglecting pollutant formation. In a later step,

you will perform an additional analysis to simulate NOx.

1. Select the Coupled Pseudo Transient solution method.

Solving → Solution → Methods...
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a. Select Coupled from the Scheme drop-down list in the Pressure-Velocity Coupling group box.

b. Retain the default selections in the Spatial Discretization group box.

c. Enable Pseudo Transient.

The Pseudo Transient option enables the pseudo transient algorithm in the coupled pressure-based

solver. This algorithm effectively adds an unsteady term to the solution equations in order to improve

stability and convergence behavior. Use of this option is recommended for general fluid flow problems.

2. Modify the solution controls.

Solving → Controls → Controls...
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a. Enter 0.25 under Density in the Pseudo Transient Explicit Relaxation Factors group box.

The default explicit relaxation parameters in ANSYS Fluent are appropriate for a wide range of general

fluid flow problems. However, in some cases it may be necessary to reduce the relaxation factors to

stabilize the solution. Some experimentation is typically necessary to establish the optimal values.

For this tutorial, it is sufficient to reduce the density explicit relaxation factor to 0.25 for stability.

b. Click Advanced... to open the Advanced Solution Controls dialog box and select the Expert tab.

The Expert tab in the Advanced Solution Controls dialog box allows you to individually specify the

solution method and Pseudo Transient Time Scale Factors for each equation, except for the flow

equations. When using the Pseudo Transient method for general reacting flow cases, increasing the

species and energy time scales is recommended.
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i. Enable the pseudo-transient method for ch4, o2, co2, h2o, and Energy in the Expert tab, by selecting

each one under On/Off.

ii. Enter 10 for the Time Scale Factor for ch4, o2, co2, h2o, and Energy.

iii. Click OK to close the Advanced Solution Controls dialog box.

3. Ensure the plotting of residuals during the calculation.

Solving → Reports → Residuals...
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a. Ensure that Plot is enabled in the Options group box.

b. Click OK to close the Residual Monitors dialog box.

4. Initialize the field variables.

Solving → Initialization

a. Retain the default Hybrid initialization method and click Initialize to initialize the variables.

5. Save the case file (gascomb1.cas.gz).

File → Write → Case...

a. Enter gascomb1.cas.gz for Case File.

b. Ensure that Write Binary Files is enabled to produce a smaller, unformatted binary file.

c. Click OK to close the Select File dialog box.

6. Run the calculation by requesting 200 iterations.

Solving → Run Calculation → Advanced...
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a. Select Aggressive from the Length Scale Method drop-down list.

When using the Automatic Time Step Method ANSYS Fluent computes the Pseudo Transient time step

based on characteristic length and velocity scales of the problem. The Conservative Length Scale

Method uses the smaller of two computed length scales emphasizing solution stability. The Aggressive

Length Scale Method uses the larger of the two which may provide faster convergence in some cases.

b. Enter 5 for the Timescale Factor.

The Timescale Factor allows you to further manipulate the computed Time Step calculated by ANSYS

Fluent. Larger time steps can lead to faster convergence. However, if the time step is too large it can

lead to solution instability.

c. Enter 200 for Number of Iterations.

d. Click Calculate.

The solution will converge after approximately 160 iterations.

7. Save the case and data files (gascomb1.cas.gz and gascomb1.dat.gz).
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File → Write → Case & Data...

Note

If you choose a file name that already exists in the current folder, ANSYS Fluent will ask

you to confirm that the previous file is to be overwritten.

13.5.8. Postprocessing

Review the solution by examining graphical displays of the results and performing surface integrations at

the combustor exit.

1. Report the total sensible heat flux.

Postprocessing → Reports → Fluxes...

a. Select Total Sensible Heat Transfer Rate in the Options list.

b. Select all the boundaries from the Boundaries selection list (you can click the select-all button ( ).

c. Click Compute and close the Flux Reports dialog box.

Note

The energy balance is good because the net result is small compared to the heat of

reaction.

Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.560

Modeling Species Transport and Gaseous Combustion



2. Display filled contours of temperature (Figure 13.3: Contours of Temperature (p. 561)).

Postprocessing → Graphics → Contours → Edit...

a. Ensure that Filled is enabled in the Options group box.

b. Select Temperature... and Static Temperature in the Contours of drop-down lists.

c. Click Display.

Figure 13.3:  Contours of Temperature

The peak temperature is approximately 2310  .

3. Display velocity vectors (Figure 13.4: Velocity Vectors (p. 563)).

Postprocessing → Graphics → Vectors → Edit...
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a. Enter 0.01 for Scale.

b. Click the Vector Options... button to open the Vector Options dialog box.

i. Enable Fixed Length.

The fixed length option is useful when the vector magnitude varies dramatically. With fixed length

vectors, the velocity magnitude is described only by color instead of by both vector length and

color.

ii. Click Apply and close the Vector Options dialog box.

c. Click Display and close the Vectors dialog box.
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Figure 13.4: Velocity Vectors

4. Display filled contours of stream function (Figure 13.5: Contours of Stream Function (p. 564)).

Postprocessing → Graphics → Contours → Edit...

a. Select Velocity... and Stream Function from the Contours of drop-down lists.

b. Click Display.
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Figure 13.5:  Contours of Stream Function

The entrainment of air into the high-velocity methane jet is clearly visible in the streamline display.

5. Display filled contours of mass fraction for  (Figure 13.6: Contours of CH4 Mass Fraction (p. 565)).

Postprocessing → Graphics → Contours → Edit...

a. Select Species... and Mass fraction of ch4 from the Contours of drop-down lists.

b. Click Display.
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Figure 13.6:  Contours of CH4 Mass Fraction

6. In a similar manner, display the contours of mass fraction for the remaining species , , and  (Fig-

ure 13.7: Contours of O2 Mass Fraction (p. 566), Figure 13.8: Contours of CO2 Mass Fraction (p. 566), and

Figure 13.9: Contours of H2O Mass Fraction (p. 567)) Close the Contours dialog box when all of the species

have been displayed.
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Figure 13.7:  Contours of O2 Mass Fraction

Figure 13.8:  Contours of CO2 Mass Fraction
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Figure 13.9:  Contours of H2O Mass Fraction

7. Determine the average exit temperature.

Postprocessing → Reports → Surface Integrals...
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a. Select Mass-Weighted Average from the Report Type drop-down list.

b. Select Temperature... and Static Temperature from the Field Variable drop-down lists.

The mass-averaged temperature will be computed as:

(13.2)

c. Select pressure-outlet-9 from the Surfaces selection list, so that the integration is performed over this

surface.

d. Click Compute.

The Mass-Weighted Average field will show that the exit temperature is approximately 1840  .

8. Determine the average exit velocity.

Postprocessing → Reports → Surface Integrals...
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a. Select Area-Weighted Average from the Report Type drop-down list.

b. Select Velocity... and Velocity Magnitude from the Field Variable drop-down lists.

The area-weighted velocity-magnitude average will be computed as:

(13.3)

c. Click Compute.

The Area-Weighted Average field will show that the exit velocity is approximately 3.30  .

d. Close the Surface Integrals dialog box.

13.5.9. NOx Prediction

In this section you will extend the ANSYS Fluent model to include the prediction of NOx. You will first calculate

the formation of both thermal and prompt NOx, then calculate each separately to determine the contribution

of each mechanism.

1. Enable the NOx model.

Setup → Models → Species → NOx Edit...
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a. Enable Thermal NOx and Prompt NOx in the Pathways group box.

b. Select ch4 from the Fuel Species selection list.

c. Click the Turbulence Interaction Mode tab.
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i. Select temperature from the PDF Mode drop-down list.

This will enable the turbulence-chemistry interaction. If turbulence interaction is not enabled, you

will be computing NOx formation without considering the important influence of turbulent fluc-

tuations on the time-averaged reaction rates.

ii. Retain the default selection of beta from the PDF Type drop-down list and enter 20 for PDF Points.

The value for PDF Points is increased from 10 to 20 to obtain a more accurate NOx prediction.

iii. Select transported from the Temperature Variance drop-down list.

d. Select partial-equilibrium from the [O] Model drop-down list in the Formation Model Parameters

group box in the Thermal tab.

The partial-equilibrium model is used to predict the O radical concentration required for thermal

NOx prediction.

e. Click the Prompt tab.
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i. Retain the default value of 1 for Fuel Carbon Number.

ii. Enter 0.76 for Equivalence Ratio.

All of the parameters in the Prompt tab are used in the calculation of prompt NOx formation.

The Fuel Carbon Number is the number of carbon atoms per molecule of fuel. The Equivalence

Ratio defines the fuel-air ratio (relative to stoichiometric conditions).

f. Click Apply to accept these changes and close the NOx Model dialog box.

2. Enable the calculation of NO species only and temperature variance.

Solving → Controls → Equations...
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a. Deselect all variables except Pollutant no and Temperature Variance from the Equations selection

list.

b. Click OK to close the Equations dialog box.

You will predict NOx formation in a “postprocessing” mode, with the flow field, temperature, and

hydrocarbon combustion species concentrations fixed. Hence, only the NO equation will be computed.

Prediction of NO in this mode is justified on the grounds that the NO concentrations are very low

and have negligible impact on the hydrocarbon combustion prediction.

3. Modify the solution controls for Pollutant no and Temperature Variance.

Solving → Controls → Controls...
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a. Click Advanced... to open the Advanced Solution Controls dialog box.

i. In the Expert tab, enable the pseudo-transient method for Pollutant no and Temperature

Variance, by selecting them under On/Off.

ii. Enter 10 for Time Scale Factor for Pollutant no and Temperature Variance.

iii. Click OK to close the Advanced Solution Controls dialog box.

b. Enter 1 for Pollutant no and Temperature Variance in the Pseudo Transient Explicit Relaxation

Factors group box.

4. Confirm the convergence criterion for the NO species equation.

Solving → Reports → Residuals...

a. Ensure that the Absolute Criteria for pollut_no is set to 1e-06.

b. Click OK to close the Residual Monitors dialog box.

5. Request 25 more iterations.

Solution → Run Calculation

The solution will converge in approximately 10 iterations.

6. Save the new case and data files (gascomb2.cas.gz and gascomb2.dat.gz).

File → Write → Case & Data...

7. Review the solution by creating and displaying a contour definition for NO mass fraction (Figure 13.10: Con-

tours of NO Mass Fraction — Prompt and Thermal NOx Formation (p. 575)).

Postprocessing → Graphics → Contours → New...
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a. Enter contour-no-mass-fraction for Contour Name.

b. Disable Filled in the Options group box.

c. Select NOx... and Mass fraction of Pollutant no from the Contours of drop-down lists.

d. Click Save/Display and close the Contours dialog box.

Figure 13.10:  Contours of NO Mass Fraction — Prompt and Thermal NOx Formation

8. Calculate the average exit NO mass fraction.

Postprocessing → Reports → Surface Integrals...
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a. Select Mass-Weighted Average from the Report Type drop-down list.

b. Select NOx... and Mass fraction of Pollutant no from the Field Variable drop-down lists.

c. Ensure that pressure-outlet-9 is selected from the Surfaces selection list.

d. Click Compute.

The Mass-Weighted Average field will show that the exit NO mass fraction is approximately 0.00421.

e. Close the Surface Integrals dialog box.

9. Disable the prompt NOx mechanism in preparation for solving for thermal NOx only.

Setup → Models → Species → NOx Edit...

a. In the Formation tab, disable Prompt NOx.

b. Click Apply and close the NOx Model dialog box.

10. Request 25 iterations.

Solution → Run Calculation

The solution will converge in approximately 6 iterations.
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11. Review the thermal NOx solution by displaying the contour-no-mass-fraction contour definition for NO

mass fraction (under the Results/Graphics/Contours tree branch) you created earlier (Figure 13.11: Contours

of NO Mass Fraction—Thermal NOx Formation (p. 577)).

Results → Graphics → Contours → contour-no-mass-fraction Display

Figure 13.11:  Contours of NO Mass Fraction—Thermal NOx Formation

Note that the concentration of NO is slightly lower without the prompt NOx mechanism.

12. Compute the average exit NO mass fraction with only thermal NOx formation.

Postprocessing → Reports → Surface Integrals...

Tip

Follow the same procedure you used earlier for the calculation with both thermal

and prompt NOx formation.

The Mass-Weighted Average field will show that the exit NO mass fraction with only thermal

NOx formation (without prompt NOx formation) is approximately 0.004174.

13. Solve for prompt NOx production only.

Setup → Models → Species → NOx Edit...

a. Disable Thermal NOx in the Pathways group box.
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b. Enable Prompt NOx.

c. Click Apply and close the NOx Model dialog box.

14. Request 25 iterations.

Solution → Run Calculation

The solution will converge in approximately 13 iterations.

15. Review the prompt NOx solution by displaying the contour-no-mass-fraction contour definition for NO

mass fraction (under the Results/Graphics/Contours tree branch) (Figure 13.12: Contours of NO Mass

Fraction—Prompt NOx Formation (p. 578)).

Results → Graphics → Contours → contour-no-mass-fraction Display

Figure 13.12:  Contours of NO Mass Fraction—Prompt NOx Formation

The prompt NOx mechanism is most significant in fuel-rich flames. In this case the flame is lean and

prompt NO production is low.

16. Compute the average exit NO mass fraction only with prompt NOx formation.
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Postprocessing → Reports → Surface Integrals...

Tip

Follow the same procedure you used earlier for the calculation with both thermal

and prompt NOx formation.

The Mass-Weighted Average field will show that the exit NO mass fraction with only prompt

NOx formation is approximately 9.975e-05.

Note

The individual thermal and prompt NO mass fractions do not add up to the levels predicted

with the two models combined. This is because reversible reactions are involved. NO

produced in one reaction can be destroyed in another reaction.

17. Use a custom field function to compute NO parts per million (ppm).

The NOppm will be computed from the following equation:

(13.4)

Note

This is the dry ppm. Therefore, the value is normalized by removing the water mole

fraction in the denominator.

User Defined → Field Functions → Custom...

a. Select NOx... and Mole fraction of Pollutant no from the Field Functions drop-down lists, and click

the Select button to enter molef-pollut-pollutant-0 in the Definition field.

b. Click the appropriate calculator buttons to enter
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*10ˆ6/(1-

in the Definition field, as shown in the previous dialog box.

Tip

If you make a mistake, click the DEL button on the calculator pad to delete the

last item you added to the function definition.

For more explicit instructions on using the Custom Field Function calculator buttons, see Intro-

duction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 121).

c. Select Species... and Mole fraction of h2o from the Field Functions drop-down lists, and click the

Select button to enter molef-h2o in the Definition field.

d. Click the ) button to complete the field function.

e. Enter no-ppm for New Function Name.

f. Click Define to add the new field function to the variable list and close the Custom Field Function

Calculator dialog box.

18. Display contours of NO ppm (Figure 13.13: Contours of NO ppm — Prompt NOx Formation (p. 581)).

Postprocessing → Graphics → Contours → Edit...

a. Select Custom Field Functions... and no-ppm from the Contours of drop-down lists.

Scroll up the list to find Custom Field Functions....

b. Click Display and close the Contours dialog box.
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Figure 13.13:  Contours of NO ppm — Prompt NOx Formation

The contours closely resemble the mass fraction contours (Figure 13.12: Contours of NO Mass Frac-

tion—Prompt NOx Formation (p. 578)), as expected.

13.6. Summary

In this tutorial you used ANSYS Fluent to model the transport, mixing, and reaction of chemical species.

The reaction system was defined by using a mixture-material entry in the ANSYS Fluent database. The

procedures used here for simulation of hydrocarbon combustion can be applied to other reacting flow

systems.

The NOx production in this case was dominated by the thermal NO mechanism. This mechanism is very

sensitive to temperature. Every effort should be made to ensure that the temperature solution is not

overpredicted, since this will lead to unrealistically high predicted levels of NO.

13.7. Further Improvements

Further improvements can be expected by including the effects of intermediate species and radiation,

both of which will result in lower predicted combustion temperatures.

The single-step reaction process used in this tutorial cannot account for the moderating effects of inter-

mediate reaction products, such as CO and . Multiple-step reactions can be used to address these

species. If a multi-step Magnussen model is used, considerably more computational effort is required

to solve for the additional species. Where applicable, the nonpremixed combustion model can be used

to account for intermediate species at a reduced computational cost.

For more details on the nonpremixed combustion model, see the Fluent User's Guide.
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Radiation heat transfer tends to make the temperature distribution more uniform, thereby lowering the

peak temperature. In addition, radiation heat transfer to the wall can be very significant (especially here,

with the wall temperature set at 300  ). The large influence of radiation can be anticipated by computing

the Boltzmann number for the flow:

where  is the Boltzmann constant (5.729 ) and  is the adiabatic flame temperature.

For a quick estimate, assume , , and  (the majority of the

inflow is air). Assume . The resulting Boltzmann number is Bo = 1.09, which shows that

radiation is of approximately equal importance to convection for this problem.

For details on radiation modeling, see the Fluent User's Guide.

This tutorial guides you through the steps to reach an initial set of solutions. You may be able to obtain

a more accurate solution by using an appropriate higher-order discretization scheme and by adapting

the mesh. Mesh adaption can also ensure that the solution is independent of the mesh. These steps

are demonstrated in Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing El-

bow (p. 121).
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